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Preface

Audience for This Guide

Welcome to Release 11i of Oracle Enterprise Install Base Implementation Guide.

This guide assumes you have a working knowledge of the following:

The principles and customary practices of your business area.
The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See the Other Information Sources section in this chapter for more information
about Oracle Applications product information.

How To Use This Guide

This document contains the information you need to understand and use Oracle
Enterprise Install Base.

Chapter 1 “Overview of Oracle Enterprise Install Base” provides overviews of
the application and its components, explanations of key concepts, features, and
functions, as well as the relationships of Oracle Enterprise Install Base to other
Oracle and third-party applications.

Chapter 2 “Implementation and Setup” provides detailed task based
procedures for implementing and setting up Oracle Enterprise Install Base.

Chapter 3 “Oracle Enterprise Install Base Administration” provides task based
procedures that are required for ongoing maintenance of Oracle Enterprise
Install Base.
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»  Chapter 4 “Oracle Enterprise Install Base API” describes the Workforce
Management API procedures for Oracle Enterprise Install Base, which you can
use to interface external workforce management systems with Oracle Enterprise
Install Base.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at

http:/ /www.oracle.com/accessibility /.

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the code examples
in this document. The conventions for writing code require that closing braces
should appear on an otherwise empty line; however, JAWS may not always read a
line of text that consists solely of a bracket or brace.

Other Information Sources

viii

You can choose from many sources of information, including online documentation
and support services, to increase your knowledge and understanding of Oracle
Enterprise Install Base.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.



Related Documentation

Oracle Enterprise Install Base shares business and setup information with other
Oracle Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Enterprise Install Base.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using

the graphical user interface (GUI) available with this release of Oracle Enterprise
Install Base (and any other Oracle Applications products). This guide also includes
information on setting user profiles, as well as running and reviewing reports and
concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Enterprise Install Base User Guide

This guide provides overviews of Oracle Enterprise Install Base application and its
components, explanations of key concepts and features.

Oracle Install Base User’s Guide

This guide provides overviews of the Oracle Install Base application and its
components, explanations of key concepts and features.

Oracle Inventory User’s Guide

This guide provides overviews of the Oracle Inventory application and its
components, explanations of key concepts and features.



Oracle Projects User’s Guide

This guide provides overviews of the Oracle Projects application and its
components, explanations of key concepts and features.

Oracle Assets User’s Guide

This guide provides overviews of the Oracle Assets application and its components,
explanations of key concepts and features.

Oracle Purchasing User’s Guide

This guide provides overviews of the Oracle Purchasing application and its
components and features and functions.

Oracle Payables User’s Guide

This guide provides overviews of the Oracle Payables application and its
components, explanations of key concepts and features.

Oracle Service Fulfillment Manager User’s Guide

This guide provides overviews of the Oracle Service Fulfillment Manager
application and its components, explanations of key concepts and features.

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.



Oracle Applications Supplemental CRM Installation Steps

This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
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products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Oracle Workflow Guide

This guide explains how to define new workflow business processes as well as
customize existing Oracle Applications-embedded workflow processes.You also use
this guide to complete the setup steps necessary for any Oracle Applications
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Enterprise Install Base implementation team, as well as for users
responsible for the ongoing maintenance of Oracle Applications product data. This
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
e€TRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.



Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.

Support

Oracle Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Enterprise Install Base
working for you. This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists with
expertise in your business area, managing an Oracle8i server, and your

hardware and software environment.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and

Upgrade/ Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.
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Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Xiv

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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Overview of Oracle Enterprise Install Base

1.1 Definition of Oracle Enterprise Install Base

Oracle Enterprise Install Base is a tracking system that integrates with and stores
information collected from Oracle Inventory, Oracle Purchasing, Oracle Projects,
Oracle Assets, Oracle Payables and Oracle Install Base.

With Oracle Enterprise Install Base, you can give users access to tracking
information without allowing them access to sensitive processes related to assets
and purchasing. You can also track inventory items after they have been installed
and link financial transactions to the physical movement of equipment.

Oracle Enterprise Install Base integrates with Oracle Install Base as its data
repository. Every transaction that Oracle Enterprise Install Base tracks will be
recorded in the Install Base transaction table and each record affected by such
transactions will be recorded in the instance and instance history tables.

1.2 Inventory ltem and Asset Tracking

To track inventory items and assets, Oracle Enterprise Install Base must interact
with several enterprise resource planning (ERP) applications. It sends to and
receives messages from those applications about the status and location of the items
you want to track.

Oracle Enterprise Install Base provides an enterprise tracking and asset
management system where all inventory, project and asset-related material
information is stored, providing a 360-degree view of your assets. Users can locate
materials anywhere in the system—in warehouses, on trucks, installed in the
network, or on project sites, facilitating financial transactions using physical
movements of material and equipment. In addition, Oracle Enterprise Install Base
can provide a life-cycle history of all activity for that equipment.

Overview of Oracle Enterprise Install Base 1-1



Inventory Item and Asset Tracking

An asset comprises a collection of items. The items may be trackable or not
trackable; the tracking is carried out in Oracle Install Base and Oracle Enterprise
Install Base.

During implementation, items are designated as trackable at the item master level
in Oracle Inventory. Oracle Enterprise Install Base tracks the activity of the trackable
items through inventory, projects, and into fixed assets.

In Oracle Assets you perform the Mass Additions concurrent process to create
assets.

1.2.1 Summary of Oracle Processes that Track Internal Products and Assets

The following diagram shows a summary of the Oracle application modules, and
the transactions and messages associated with Oracle Enterprise Install Base.

Figure 1-1 Summary of Oracle processes that track internal products and assets

Oracle Purchasing

PO Receiving ™ Oracle Enterprise Install Base Oracle Projects
# P Manage Costs
Oracle Inventory - Interface to Assets
Trapsfors Create Install BazeInstances A
Mowve Orders
Issues to Project Manage Usage ¥
Misc Izsues ‘P , Oracle Assets
Misc, Receipts Track Location .
Physical Inventory . . -« Depreciate Assets
Cycle Count Create Project Expenditures
& Create Assets
h A Oracle Payables
Oracle Enterprise Update AssetLocation , , ,
Install Base —p Invoice Price Variances
Worldorce Management FProcess Retirements
Install/ Remove .
In Service L Adjust Asset Cost
Cut of Service e
Ttemn Move

For example, when a field service technician enters a report that equipment has
been placed into service, the workforce management system may send a message to
Oracle Enterprise Install Base. This message updates the status of the equipment to
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Features of Oracle Enterprise Install Base

“In Service,” and gives its in-service date to Oracle Projects. The asset is now ready
to be created in Oracle Assets.

1.2.2 Messaging Architecture in Oracle Enterprise Install Base

The messaging architecture receives requests from external publishing systems in
eXtensible Markup Language (XML) format. Based on the input requirements, the
application updates the status and keeps a history of transactions for the tracking
unit. Subsequently, the application publishes outgoing requests to the subscribing
systems for further processing. The publishing and subscribing systems include:
Install Base, inventory, purchasing, payables, assets, projects, workforce
management, and other legacy system.

1.3 Features of Oracle Enterprise Install Base

1.3.1 Functional Overview

This application supports the standard functions found in Oracle Inventory, Oracle
Purchasing, Oracle Projects, and Oracle Assets.

Oracle Enterprise Install Base supports the following functions (that is, item
instances are not updated if you perform inventory transactions other than those in
the following list):

= Purchase order receipt of items into inventory
= Purchase order receipt of items into operating projects
= Move orders

= Miscellaneous issue to a project

= Miscellaneous receipt from a project

» Installation and uninstallation of equipment

= In-Service/Out-of-Service of equipment

= Subinventory transfers

» Inter-organization transfers

= Miscellaneous receipts and issues

= Placement of assets into or out of service

= Retirement and reinstatement of the partial or full cost of an asset

Overview of Oracle Enterprise Install Base 1-3



Integration Points and Dependencies for Oracle Enterprise Install Base

s Assetitem moves and asset item transfers

= Physical counts

1.4 Integration Points and Dependencies for Oracle Enterprise Install
Base

Oracle Enterprise Install Base has the following integration points with Oracle
Applications:

= Oracle Inventory

s Oracle Purchasing

s Oracle Order Management
s Oracle Payables

= Oracle Assets

= Oracle Projects

1-4 Oracle Enterprise Install Base Implementation Guide



2

Implementation and Setup

2.1 Setup Checklist

Oracle Enterprise Install Base has an ability to track an item instance regardless of
the location and also to perform the financial updates automatically.

Users may use both the tracking and financial update functionality or just the
instance tracking capability.

If you are not using asset creation through Oracle Enterprise Install Base, then you
do not have to perform the setups in Oracle Projects and Oracle Assets.

The following table is a comprehensive list of all setup steps that must be
completed:

Table 2-1 Oracle Enterprise Install Base Module Profile Option Settings

Step

Step Title

O 00 NN N G ok W N

—_
o

Install required Oracle application modules

Define users with required responsibilities

Define system profile options for Oracle Enterprise Install Base
Define system profile options for all the dependent responsibilities
Define Oracle Inventory parameters

Define Oracle Purchasing parameters

Define Oracle Payables parameters

Define Oracle Projects parameters

Define Oracle Assets parameters

Perform Oracle Install Base setup tasks
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Install Required Oracle Application Modules

Note: If you are only an Oracle Install Base user and want to track
only customer products, then perform steps 2 and 4 only.

2.2 Install Required Oracle Application Modules

The following Oracle application modules must be installed and set up before you
set up Oracle Enterprise Install Base:

Oracle Inventory
Oracle Projects

Oracle Assets

Oracle Purchasing
Oracle Payables
Oracle General Ledger
Oracle Install Base

Oracle Service Fulfillment Manager

You must also install the following if you are using internal sales orders for normal
items:

Oracle Order Management

Use a standard setup for Oracle Purchasing, Oracle Assets, Oracle General Ledger,
Oracle Payables. For detailed setup information on all of these applications consult
the appropriate documentation set.
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Define System Profile Options for Oracle Enterprise Install Base

Note: You must also install and set up Oracle Human Resource
Management System (HRMS).

In Oracle HRMS, you must set up users with the ability to approve
purchase orders.

For detailed setup information on Oracle HRMS, please refer to the
Oracle HRMS implementation documentation appropriate to the
country where the application is being installed.

2.3 Define Users with Responsibilities in Oracle Application Modules

After you have installed the required Oracle application modules, you must define
users with responsibilities to enable users to perform the appropriate tasks in each
application module.

For more information on setting up responsibilities and users, see the Oracle
Applications System Administrator’s Guide.

2.4 Define System Profile Options for Oracle Enterprise Install Base

The system profile options for Oracle Enterprise Install Base determine how
messages are dequeued, where the history file for debugging is located, and where
event notifications are sent.

Use the System Profile Values window to make changes to your profile settings. Do
not enter user values unless you require a setting that is different from the default
setting.

Steps
1. From the Navigator for the System Administrator responsibility, choose Profile
> System.

2. In the Profile Name field of the Find System Profile Values window, enter CSE%
and click Find.

In the System Profile Values window, define the profile options as follows:
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Define System Profile Options for All Dependent Responsibilities

Table 2-2 Oracle Enterprise Install Base Module Profile Option Settings

Profile Name Default Value

Profile Option Function Required

CSE: Debug Log Directory /sqlcom/temp/

CSE: Debug Option Y

CSE: FA Book Type Code

CSE: PA Expenditure Type

CSE: Use elB Costing Y
Hook

Sets the file and directory of Y
the debug log file. DBA can
create own path of directory

for fog file

Enter Y (yes) or N (no) to Y
control the debugging

function for the message
dequeuer.

This option is used to set Optional
the default FA book type

code for creating asset from
depreciable item.

The default expenditure Optional
type, used when material is
issued to a project.

This must be set to "Y" if Y
you are using Oracle
Enterprise Install Base.

2.5 Define System Profile Options for All Dependent Responsibilities

After the modules Oracle Inventory, Oracle Projects, Oracle Assets, Oracle
Purchasing, Oracle Payables, Oracle General Ledger, Oracle Install Base and Oracle
Service Fulfillment Manager have been installed, you must define a number of
system profile options for each responsibility associated with each dependent
Oracle application module, as well as Oracle Enterprise Install Base itself.

Table 2-3 shows the full list of the responsibilities that are required for each of the

profile options.

Table 2-3 Responsibilities Required for Profile Option Setup

Oracle Application Module

Sample Responsibility Name*

Oracle Inventory
Oracle Purchasing
Oracle Payables

Oracle Projects

2-4 Oracle Enterprise Install Base Implementation Guide

Inventory Manager
Purchasing Manager
Payable Manager
CRL 11i Projects



Define System Profile Options for All Dependent Responsibilities

Table 2-3 Responsibilities Required for Profile Option Setup

Oracle Application Module Sample Responsibility Name*
Oracle Assets Assets Manager

Oracle General Ledger General Ledger

Oracle Install Base Install Base Administrator
Oracle Enterprise Install Base Enterprise Install Base Manager
Oracle Order Management Order Management Super User

Note: The responsibility names in the table are sample
responsibility names. For your installation, use the appropriate
equivalent responsibility name or names set up for each Oracle
application module.

Table 24 shows the supplementary profile options that are required to be set up.
The table first shows the profile options that must be set up for each of the
responsibilities listed in Table 2-3. This is followed by the profile options that are
required for specific responsibilities only.

Table 2-4 Supplementary Profile Options Required for Oracle Enterprise Install Base

Profile Options Profile Level Responsibilities

MO: Operating Unit Responsibility All responsibilities in Table 2-3
GL Set of Books Name Responsibility All responsibilities in Table 2-3
MO: Security Profile Responsibility All responsibilities in Table 2-3
HR: Business Group Responsibility All responsibilities in Table 2-3
HR: Security Profile Responsibility All responsibilities in Table 2-3
FA: CRL Assets Enabled Responsibility All responsibilities in Table 2-3
PA: Licensed to use CRL Projects  Site, Responsibility ~ All responsibilities in Table 2-3
Service: Inventory Validation Responsibility Oracle Enterprise Install Base
Organization Oracle Install Base

Order Management
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Define Oracle Inventory Parameters

Table 2-4 Supplementary Profile Options Required for Oracle Enterprise Install Base

Profile Options Profile Level Responsibilities

QP: Item Validation Organization = Responsibility Oracle Enterprise Install Base

Oracle Install Base

Order Management

Steps

1.

From the Navigator for the System Administrator responsibility, choose Profile
> System.

For each combination of responsibility in Table 2-3 and profile option in
Table 2—4, perform steps 2 through 5:

In the Responsibility field of the Find System Profile Values window, enter the
appropriate responsibility (e.g. Inventory, Vision Enterprises).

In the Profile Name field of the Find System Profile Values window, enter the
Profile Value and click the Find button.

Enter the appropriate value at the Responsibility level (and Site level where
required).

Choose File > Save to save your work.

2.6 Define Oracle Inventory Parameters

This section discusses the conectps and setup steps in Oracle Inventory that have a
bearing on how Oracle Enterprise Install Base functions.

The topics in this section are as follows:

Tracking

Depreciable Items

Serial Number Control

General Oracle Inventory Considerations
Define Organization Classifications
Define Organization Parameters

Define User-Definable Transaction Types

Define Normal Items
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Define Oracle Inventory Parameters

= Define Depreciable Items
= Associate Subinventories to Locations
= Define Inventory Period

» Additional Oracle Inventory Setup Considerations

2.6.1 Tracking

When an item is Oracle Enterprise Install Base trackable, any activity for that item
passes a message to Oracle Enterprise Install Base for tracking.

You perform the task of making an item trackable by both Oracle Install Base and
Oracle Enterprise Install Base in Oracle Inventory, as follows:

= When you define a master item, then, to make the item trackable, check the
Install Base tracking checkbox on the Service tab.

You must define the item as trackable at the master organization level only. Items
become Install Base trackable (and Enterprise Install Base trackable) across all
organizations. Do not change this item attribute at the organization level.

Additional Tracking Considerations

The Install Base tracking attribute of an item cannot be changed when on-hand
quantity is greater than zero.

Attribute changes are not applied to pre-existing transactions in the Oracle
Enterprise Install Base record. If you change the tracking attribute of an item from
No to Yes, transactions that occurred before the change have no record in Oracle
Enterprise Install Base. If you change the tracking attribute of an item from Yes to
No, Oracle Enterprise Install Base no longer processes the pre-existing transactions.

2.6.2 Depreciable ltems

Items that are trackable by Enterprise Install Base are defined as either normal or
depreciable items. The difference between normal and depreciable items is in the
way that assets can be created from the items.

For a normal item, the asset is created after an item is put in service. For a
depreciable item, the asset is created when an item is received, either in Oracle
Inventory or Oracle Projects.

For a depreciable item, you must define the item as depreciable at the master
organization level only. Do not change this item attribute at the organization level.
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Define Oracle Inventory Parameters

For more details, see Section 2.6.8, "Define Depreciable Items".

2.6.3 Serial Number Control

You must designate serial number control for the trackable items at the master
organization level. This ensures that serial number control for an item is the same
across all inventory organizations. Do not change this item attribute at the
organization level.

You specify serial number control in the Inventory tab.

Do not change serial control for an item after transactions have been entered.

Additional Serial Number Control Considerations

In Oracle Inventory, you may enter a miscellaneous issue transaction to remove all
on-hand inventory, change the serial control attribute, then enter a miscellaneous
receipt to restore the on-hand quantities. During the process of correcting on-hand
quantities, items that already have transactions are not affected. As a result records
in Oracle Enterprise Install Base do not show the change in the serial control
attribute.

2.6.4 General Oracle Inventory Considerations

In addition, follow these restriction guidelines when setting up Oracle Inventory:

= Define all Oracle Enterprise Install Base items as inventory items (Inventory
tab).

If the Inventory Item checkbox is not marked, you cannot store or move the
item.

= Enable Inventory Asset and Costing Enabled attributes for all items in Oracle
Enterprise Install Base (Costing tab).

These attributes let you enter and maintain costs for the items.

= Do not modify the Oracle Account Generator logic for deriving the depreciation
expense account.

The depreciation expense account is derived from the book type (corporate or
tax) and the asset category. Oracle Enterprise Install Base assumes that the
depreciation expense account remains unchanged as a result of subinventory or
inter-organization transfers.
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2.6.5 Define Organization Classifications

Oracle Enterprise Install Base tracks those inventory items which you have defined
as Enterprise Install Base-tracking. Each module that interacts with Oracle
Enterprise Install Base passes messages that contain specific information for all
items that are marked as Enterprise Install Base-tracking. For these messages to be
sent and received successfully, the organizations you define must have the
following classifications:

= HR Organization

Use to associate employees, such as buyers and planners, with items within the
organization.

= Inventory Organization
Use to define, maintain, transact, and have on-hand balances for item numbers.
= Project Expenditure/Event Organization and Project Task Owning Organization

Allows Oracle Inventory to associate items assigned to project and tasks to a
project clearing account, which collects the cost of that assigned material. Use to
monitor the expenditures for a project and task by reviewing the account
through Oracle Projects. You use capital projects to collect
construction-in-process (CIP) and expensed costs for assets you are building.
When you are ready to place the asset in service, you generate asset lines from
the CIP costs in Oracle Projects. You can send these lines to Oracle Assets to
become depreciable, fixed assets. Therefore allow entry of capital project in
your organization and issue material to the Capital Projects only.

You must specify any additional classifications you need for your organization.

2.6.5.1 Define Organization Parameters

When you issue material to projects and tasks, all costs are initially charged to a
project clearing account. This account provides a convenient check point for
tracking project costs.

Project Cost Collection Enabled must be checked on the Costing Information tab.
These attributes let you enter and maintain costs for the items.

The organization parameters described below ensure that the costs associated to a
project or task are passed to the clearing account for the Inventory organization that
has been set up to own inventory items.

Use these steps to define organization parameters.
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Prerequisites

You must define your organizations when you set up Oracle Inventory before you
can define the organization parameters.

Steps
1. In the Inventory responsibility, navigate the path Setup > Organizations >
Parameters.

2. Inthe Organization Parameters window, click the Inventory Parameters tab and
enter:

a. The Move Order Timeout Period
b. The Move Order Timeout Action
3. Click the Costing Information tab and check Project Cost Collection Enabled.

4. Click the Other Accounts tab and enter the organization’s Project Clearing
Account number.

5. Choose File > Save to save your work.

2.6.6 Define User-Definable Transaction Types

Under the Inventory responsibility, you must define certain user-definable
transaction types.

The following transactions must be defined to use Oracle Enterprise Install Base
miscellaneous transactions.

Table 2-5 Required Transaction Types

Name Source Type Action Checkbox

elB Issue to Project Move Order  Issue from Store ~ Check on Project
Miscellaneous Issue to Project Inventory Issue from Store ~ Check on Project
Miscellaneous Receipt from Project Inventory Receive into Store  Check on Project

You do not have to use the transaction type names as shown in the table. However,
you must specify the source type and action as shown and select the Project
checkbox for each of the transaction types required for Oracle Enterprise Install
Base.
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Steps

1.
2.
3.
4.

In the Inventory responsibility, navigate the path Setup > Transactions > Types.
In the Transaction Types window, click the User tab.
Enter name, source type, action, and checkbox.

Choose File > Save to save your work.

2.6.7 Define Normal ltems

You must define an item master organization and at least one organization in Oracle
Enterprise Install Base.

Steps

1.
2.

In the Inventory responsibility, navigate the path Items > Master Items.

In the Master Item window, enter the appropriate information into the header
region of the window.

Click the Inventory tab.

Check Inventory Item.

Stockable and Transactable are checked by default.

Select the Service tab and check Install Base Tracking.

Enter or select information in the remaining fields of the window.

Choose File > Save to save your work.

2.6.8 Define Depreciable ltems

You must define an item master organization and at least one organization in Oracle
Enterprise Install Base.

Steps

1. In the Inventory responsibility, navigate the path Items > Master Items.

2. In the Master Item window, enter the appropriate information into the header
region of the window.

3. Click the Inventory tab.

4. Check Inventory Item.
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Stockable and Transactable are checked by default.
5. Select the Service tab and check Install Base Tracking.

6. Choose Create Depreciable Inventory Asset from the list of values of the Asset
Creation field.

7. Enter or select information in the remaining fields of the window.

8. Choose File > Save to save your work.

2.6.9 Associate Subinventories to Locations

Associate asset subinventories to a location.

= Use the Location field in the subinventory setup to link the deliver-to location
of the item with its asset location.

Note: This is a standard setup step in Oracle Inventory. For more
details, see the Oracle Inventory Implementation Guide.

2.6.10 Define Inventory Period

Set the first inventory period, make sure you align this with the current period of
the other modules.

Prerequisites
None

Steps
1. In the Inventory responsibility, navigate the path Accounting Close Cycle >
Inventory Accounting Periods.

2. In the Inventory Accounting Periods window, in the first Period region, enter
the current period.

3. Choose File > Save to save your work.

Note: This is a standard setup step in Oracle Inventory. For more
details, see the Oracle Inventory Implementation Guide.
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2.6.11 Additional Oracle Inventory Setup Considerations

Assigning Cost to Install Base Tracking Iltems

You must assign cost to each item that is Install Base tracking if you are using
Oracle Projects to accrue the expenditures.

Define Shipping, Inter-Organization Shipping

Use the Inter-Organization Shipping window to define accounting information and
the relationships that exist between shipping and destination organizations. You can
specify whether an organization is a shipping organization, a destination
organization or both. For more information see the Oracle Inventory User Guide.

Note: For details on Oracle Inventory setup steps, please refer to
the Oracle Inventory Implementation Guide.

2.7 Define Oracle Purchasing Parameters

When an organization receives an item, the subinventory material account is
debited and the AP accrual account is credited. When the item is issued to a project
and the cost collection process is run, the project clearing account is debited and the
project’s account is credited.

To ensure that Oracle Enterprise Install Base picks up the Project clearing account
for the charge account of purchase order, modify Oracle Account Generator as
follows:

PO charge account = project clearing account

This modification ensures that the project clearing account used in the organization
matches the credit account generated by auto-accounting for receipt transactions.

In addition, be aware of the following restrictions when setting up Oracle
Purchasing:

= Set the match approval level to at least three-way matching.

Oracle Enterprise Install Base uses purchase order and invoice data to
determine and adjust costs. Three-way matching ensures that the purchase
order quantity, the receipt quantity, and the invoice quantity all match. You can
also set the match approval level higher, to four-way matching.
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If your organization’s default matching method is less than three-way, update
the matching level setting on the purchase order itself.

= Assign an asset category to Enterprise Install Base tracking items.

The asset category must not be an expense category and must belong to the
same Assets book as the book used by the Profile Option CSE:FA Book Type
Code.

For details of setting up the profile options, see Section 2.4, "Define System
Profile Options for Oracle Enterprise Install Base".

Note: For details on Oracle Purchasing setup steps, please refer to
the Oracle Purchasing Implementation Guide.

Oracle Enterprise Install Base uses this purchasing item attribute to derive the asset
category it uses when it creates asset records. Set control of this attribute at the
master organization level so that the asset category for an item is the same across all
inventory organizations.

2.8 Define Oracle Payables Parameters
The following is a list of Oracle Payables setup tasks:
= Match Invoice to Purchase Order

= Define Invoice Quantity Tolerance

2.8.1 Match Invoice to Purchase Order

Oracle Enterprise Install Base uses purchase order and invoice data to adjust asset
cost.

1. In the Payables responsibility, navigate the path Setup > Options > Financials.
2. In the Financials Options window, click the Supplier - Entry tab.
3. Set the Invoice Match Option to Purchase Order.

2.8.2 Define Invoice Quantity Tolerance

Define the quantity tolerance in Oracle Payables as zero.
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s The method Oracle Enterprise Install Base uses to calculate invoice price
variance (IPV) requires this restriction. However, price tolerances are permitted.

2.9 Define Oracle Projects Parameters
The following is a list of Oracle Projects setup tasks:
= Define a Descriptive Flexfield for Expenditure Items
= Set Up Asset Creation Grouping Methods for Project Expenditure Items

= Additional Oracle Projects Setup Considerations

2.9.1 Define a Descriptive Flexfield for Expenditure ltems

The expenditure item descriptive flexfield is mandatory for asset creation. It
provides a way to view the attributes or grouping method values of an item.

1. Inthe CRL 11i Projects responsibility, navigate the path Projects > Setup >
Flexfields > Descriptive > Segments.

2. In the Descriptive Flexfield Segments window, create the descriptive flexfield
for the application Oracle Projects with the title Expenditure Items.

3. Click Segments.

4. Refer to the following table to define the five segments in the flexfield.
Table 2-6 Segments in the Expenditure Items flexfield

Name Window Prompt  Column Value Set

Item Number Item Number ATTRIBUTE6 50 chars (no validation)

Serial Number Serial Number ATTRIBUTE?7 50 chars (no validation)

Category Category ATTRIBUTE8  Oracle Enterprise Install Base
Asset Category (FA_
CATEGORIES table)

Location Location ATTRIBUTE9  Oracle Enterprise Install Base
Location (FA_LOCATIONS table)

Product3 Product3 ATTRIBUTE10 PA Product Value (PA_
SEGMENT_VALUE_LOOKUPS
table)

5. Check the Displayed checkbox for all five segments in the flexfield.
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6. Save the data you have entered, then close the Segments Summary - Global
Data Elements window.

7. Back in the Descriptive Flexfield Segments window, select the checkbox Freeze
Flexfield Definition.

8. Click Compile.

Note: In a subsequent step of setting up asset creation grouping
methods, the asset creation options GROUPING ELEMENT]1,
GROUPING ELEMENT?2, and GROUPING ELEMENTS3 correspond
respectively to the columns ATTRIBUTES, ATTRIBUTE9, AND
ATTRIBUTE10 defined in the Expenditure Items descriptive
flexfield.

See Section 2.9.2, "Set Up Asset Creation Grouping Methods for
Project Expenditure Items".

2.9.2 Set Up Asset Creation Grouping Methods for Project Expenditure ltems

An asset can be created before a project is completed. The asset must be associated
to location and asset category information. Oracle Projects can send the associated
information to Oracle Enterprise Install Base and Oracle Assets. In turn, Oracle
Enterprise Install Base uses this information to update the assets and the inventory
system.

Use this procedure to ensure that the assets created in Oracle Projects are associated
to the required location and asset category information.

Prerequisites
None.

Steps
1. In the CRL 11i Projects responsibility, select Asset Creation.

The Asset Naming Convention window appears, with the screen divided into
several screen area names, and fields in each screen area.

Note: The screen area Define Asset Description contains three fields.
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2. In the Asset Naming Convention window, use the lists of values to select the
option values for each screen area name, as shown in the following table:

Table 2-7 Define Asset Creation

Screen Area Name Option Value

Define Asset Name Task Name
Define Asset Description ~ Grouping Elementl ~ Grouping Element2 Task Name
Location Grouping Element2

Category Grouping Element1

Note: For Location and Category, the Grouping Element Number
must correspond with attribute 8, 9, or 10, depending on which
attribute was chosen to indicate location and category in the
system-level descriptive flexfield setup.

See Section 2.9.1, "Define a Descriptive Flexfield for Expenditure
Items".

3. Choose File > Save to save your work.

2.9.3 Additional Oracle Projects Setup Considerations
Note these restriction guidelines when setting up Oracle Projects:
= Issue Enterprise Install Base-tracking items only to Capital-type projects.

Oracle Projects cannot create assets in Oracle Assets from projects that are not
the Capital type. If items are issued to projects of either Contract or Indirect
type, then Oracle Enterprise Install Base does not have a record of the asset ID.
When you generate asset lines, no asset lines are generated for those items that
do not belong to the Capital-type project.

= Issue Enterprise Install Base-tracking items only to tasks that can be capitalized.
You can generate asset lines only on tasks that have been capitalized.

= Do not send installation and in-service messages against projects that have a
Closed status.

Implementation and Setup 2-17



Define Oracle Assets Parameters

Oracle Enterprise Install Base does not validate whether or not the project has a
Closed status. It continues to change the item status to Installed or In Service.
However, you cannot generate asset lines against a closed project.

= Asset generation will only be done for projects with project types which have
User Defined Grouping Method as CIP method.

Note: For details on Oracle Projects setup steps, please refer to
Oracle Projects Setup and Implementation in the Oracle Projects
User Guide.

2.10 Define Oracle Assets Parameters

The definitions of the Asset Locator and Asset Category key flexfields must be
compatible with the segments of the expenditure item descriptive flexfield defined
in a previous section. For more details, see Section 2.9.1, "Define a Descriptive
Flexfield for Expenditure Items".

If you use group depreciation with Oracle Projects and Oracle Assets, you must
define the Group Asset and Super Group key flexfields. The recommended values
are shown in the following table.

Note: For details on Oracle Assets setup steps, please refer to the
Oracle Assets Implementation Guide.

Table 2-8 Define Group Asset and Super Group key flexfields

Application Key Flexfield Suggested Segment Values
Oracle Assets Group Asset (1) City, (2) Network Element
Oracle Assets Super Group (1) Region, (2) Product Line

In addition, be aware of the following:

= Do not change or delete the link between the deliver-to and asset location once
an asset has been created.

Use the Locations form in Oracle Enterprise Install Base to initially link
deliver-to and asset location. After this initial link is created, changing or
deleting the link could corrupt the asset record.
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= When assets are created through Oracle Enterprise Install Base, the asset key
flexfield value is null.

If you want need Oracle Enterprise Install Base to automatically populate this
value, you must customize the application.

= All assets must be related to an asset category. The Asset category will drive the
depreciable for the asset.

= The Oracle Assets book type is designated by the profile option CSE: FA Book
Type Code.

= When you define Asset Groups you are required to define the depreciation
method you will only find methods which have a calculation method of Flat
Rate.

2.11 Perform Oracle Install Base Setup Tasks

After Oracle Inventory, Oracle Projects, Oracle Assets, Oracle Purchasing, and
Oracle Payables have been installed and set up, you must set up set up some
parameters for Oracle Enterprise Install Base using the Oracle Install Base
Administrator responsibility (or the equivalent responsibility as set up in your
installation).

During the integration setup of Oracle Enterprise Install Base, you determine:
»  How HZ locations, HR locations (inventory locations) map to asset locations

The setup steps required for Oracle Enterprise Install Base which are performed in
Oracle Install Base are:

s Section 2.11.1, "Define HZ Locations"
s Section 2.11.2, "Associate HR and HZ Locations to Asset Locations"

s Section 2.11.3, "Set the Freeze Install Parameter”

2.11.1 Define HZ Locations

Oracle Enterprise Install Base has the ability to correlate HR locations to HZ
locations. HR locations are inventory locations used to receive material. HZ
locations are used to deploy equipment in the field.

You need to establish the link between HR locations and HZ locations in order to
perform automatic financial updates when a material movements occur.

After you have defined asset locations, you must define HZ locations.
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Prerequisites
You must have defined organizations in Oracle Inventory.

You must have set up the profile options for Oracle Inventory and Oracle Assets.For
details, see Section 2.5, "Define System Profile Options for All Dependent
Responsibilities".

You must have set up asset locations in Oracle Assets. For more information, see the
Oracle Assets User Guide.

Steps

1. In the Oracle Install Base responsibility, choose Setups > Maintain Locations.
2. Enter complete address in HZ location setup window.

3. Enter the description of the HZ location.

4. Enter the HZ location code.
5

Choose File > Save to save your work.

2.11.2 Associate HR and HZ Locations to Asset Locations

Assign HR and HZ locations to the Asset location using Asset Location Setup.

Prerequisites
HR and HZ locations must be defined.

Steps

1. In the Oracle Install Base responsibility, choose Setups > Asset Location Setup.
Select location source as HR or HZ.
Choose location code from the list of values.

Assign Asset location.

2

3

4

5. Enter active start date.

6. You can disable the particular relationship by entering active end date.
7

Choose File > Save to save your work.

2.11.3 Set the Freeze Install Parameter

You must make sure the Install Parameter Freeze checkbox is checked.
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Prerequisites
None.

Steps
1. In the Oracle Install Base responsibility, navigate the path Setups > Install
Parameters.

2. In the Install Parameters window, check the Freeze checkbox.
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3

Oracle Enterprise Install Base
Administration

3.1 Administering Oracle Enterprise Install Base

This topic group provides task-based procedures that are required for ongoing
system maintenance and includes information on administration tools and utilities.

3.1.1 Each Transaction Generates a Message

Every transaction of a trackable item generates a message to the application. When
the application receives a message, it searches the Oracle Enterprise Install Base
tables for a record of the item. If it finds the record and all the attributes have been
defined in the record, the transaction occurs without errors.

However, when a transaction results in an error, the related message is sent to the
appropriate log. For example, if a Receipt-to-Project transaction of a normal item is
missing attributes for category or location, a fatal error occurs. The message that is
sent as a result of this transaction is sent to the Error Log.

3.1.2 Transaction Status Complete (C)

The application changes the status of a transaction to Complete (C), when the
following conditions are met:

= The transaction has not generated any errors
s The transaction is complete

= The transaction is not dependent on another incomplete transaction
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3.1.3 Understanding the Message Dequeuer

A message dequeuer is a background process that continuously polls a queue and
processes the items from the queue. The message dequeuer removes messages from
the message queue on a first-in, first-out (FIFO) basis. Message queues are
maintained by Oracle Advanced Queueing (OAQ). For information about message
queues, see the following topics in the Oracle Service Fulfillment Manager Concepts
and Procedures guide:

= Messaging in Oracle Service Fulfillment Manager
= Managing the System Queues

You can manage the message queues in either Oracle Service Fulfillment Manager
or Oracle Number Portability. Oracle Enterprise Install Base uses the messaging
system that is maintained in Service Delivery Platform (SDP).

When you start a message queue, a controller process automatically starts the
dequeuers. For more information about starting and suspending a message queue,
see the following topics in the Oracle Service Fulfillment Manager Concepts and
Procedures guide:

= Oracle SDP Start
= Oracle SDP Stop

Before starting the transaction make sure that the Service Fulfillment Manager
queue is running. To do that, perform the following steps:

1. Change the responsibility to SFM System Administrator.
2. Navigate the path Concurrent > Administer Manager.

3. Make sure SFM Event Manager Queue Service is running.

3.2 Bypassing the Service Fulfillment Queue

Oracle Enterprise Install Base does not recommend bypassing the service fulfillment
queue. Bypassing a queue may cause slower applications performance. However
you have a choice of using the queue or bypassing it. To bypass, simply set the
Oracle Install Base parameter SFM Bypass. Once you set this option then the
transactions will be directly updated to Oracle Enterprise Install Base.

There is no change in the standard business flows except for the asset retirements. If
you are bypassing the service fulfillment queue, then after asset retirement you
need to run the Oracle Enterprise Install Base concurrent program Import Asset
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Retirement - Reinstatement Transactions Report. This will update the CSI_I_
ASSETS table in Oracle Install Base.

When you choose this option, then you may set the Inventory Transaction
Processing user profile as described below:

s TP:INV Transaction Processing Mode
This profile option indicates the processing control for transacting items.

Available values for transaction items are shown in Table 3-1, as follows:

Table 3—1 Available values for transaction items

Processing Description

On-line processing Processes transactions while you wait, and control is returned
once transaction processing is completed.

Background Processing Upon commit, control returns immediately to you, allowing
you to processing continue working. The transactions are
executed on a periodic basis.

Immediate concurrent Upon commit, Oracle Inventory spawns the concurrent
processing process and returns control immediately to you, allowing you
to continue working.

Displays the concurrent request number of the concurrent
process executing the transaction.

Form level processing Processes transactions using the processing control option you
choose for that particular type of transaction. You must also
set the Oracle Inventory profile options for Inter-Organization
Transfer, Miscellaneous Issue and Receipt, Receive Customer
Return, Return to Customer, and Transfer Between
Subinventories..

The value you choose for this profile overrides values you set for individual
transaction profiles unless you choose Form level processing. Oracle Inventory
predefines a value of Immediate concurrent processing for this profile for all levels
upon installation. This profile is updatable at all levels.

For more information please refer to the Inventory Profile Options section in the
Oracle Inventory User’s Guide.
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4

Oracle Enterprise Install Base API

This documents describes the Workforce Management APIs for Oracle Enterprise
Install Base.

You can use external Workforce Management Systems along with Oracle Enterprise
Install Base. Oracle Enterprise Install Base has the ability to integrate with the
external workforce management applications through the APIs. Call these APIs to
update Oracle Enterprise Install Base when the item is Installed or Uninstalled,
when the item is put in service or out of service and when the item is out of service
or the item is moved.

The topics in this section are as follows:
= Section 4.1, "Oracle Enterprise Install Base Public Package"
= Section 4.2, "Contents of Package CSE_WFMSG_TRX_PKG"

4.1 Oracle Enterprise Install Base Public Package

The APIs provided for Oracle Enterprise Install Base are organized into the
following package:

s  CSE_WEFMSG_TRX_PKG

This package contains all procedures to manage item instances for workforce
management transactions.
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Table 4-1 CSE_WFMSG_TRX_PKG APIs

Name

Description

Proj_Item_Installed

Proj_Item_Uninstalled

Proj_Item_In_Service

In_Service

Out_Of Service

The prerequisite is that you must have an instance with
the usage code In-Process for the item you are trying to
install. This procedure creates/updates the item instance
with the usage code Installed, location type code from
Project to HZ_locations. If there is an existing instance
with usage code Installed, then it updates the same or
otherwise it will create a new instance.

The prerequisite is that you must have an instance with
the usage code Installed for the item you are trying to
uninstall. This procedure updates the item instance with
usage code In-Process, location type code from HZ,_
locations to Project.

The prerequisite is that you must have an instance with
the usage code Installed for the item you are trying to put
into service. This procedure creates/updates the item
instance with usage code In-Service. If there is an existing
instance with usage code In-Service, then it updates the
same or otherwise it will create a new instance. This
procedure creates expenditure items in the projects
interface table. The transactions created by this procedure
will be used by Create Assets for Normal Items program.

The prerequisite is that you must have an instance with
the usage code Out-of-Service for the item you are trying
to put in service. This procedure creates/updates the item
instance with usage code In-Service. If there is an existing
instance with usage code In-Service, then it updates the
same or otherwise it will create a new instance.

The prerequisite is that you must have an instance with
the usage code In-Service for the item you are trying to
put out of service. This procedure creates/updates the
item instance with usage code Out-of-Service. If there is
an existing instance with usage code Out-of-Service, then
it updates the same or otherwise it will create a new
instance.
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Table 4-1 CSE_WFMSG_TRX_PKG APIs

Name

Description

Item_Move

The prerequisite is that you must have an instance with
the usage code Out-of-Service for the item you are trying
to move. This procedure creates/updates the network
location of the item instance with usage code
Out-of-Service. If there is an existing instance with usage
code Out-of-Service, network location as From Network
Location, then it updates the network location with To
Network Location or otherwise it will create a new
instance with usage code Out-of-Service, network location
as To Network Location. The transactions created by this
procedure will be used by the Interface Move Transactions
to Fixed Assets concurrent program.

4.2 Contents of Package CSE_WFMSG_TRX_PKG

Contains all APIs for instance management for workforce management

transactions.

s Proj_Item_Installed

s Proj_Item_Uninstalled

s Proj_Item_In_Service

s In_Service

s Out_Of Service

s Item_Move

4.2.1 Proj_ltem_Installed

Procedure Proj_Item_Installed

(p_item_id
p_revision
p_lot_number
p_serial_number
p_quantity
p_project_id

IN NUMBER,
IN VARCHAR?2,
IN VARCHAR?2,
IN VARCHAR?,
IN NUMBER,
IN NUMBER,
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p_task_id IN NUMBER,
p_network_loc_id IN NUMBER,
p_party_site_id IN NUMBER,
p_work_order_number IN VARCHAR?2,
p_transaction_date IN DATE,
p_transacted_by IN NUMBER,
p_return_status OUT VARCHAR?2,
p_error_msg OUT VARCHAR?2)

Parameter Descriptions
The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number =~ VARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
p_project_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the project
p_task_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the task
_network_ NUMBER NOT (see CLLI code from HZ_LOCATIONS
oc_id NULL ErdeCrlptlon One, and only one, of the two
Validations) parameters p_network_loc_id and

p_party_site_id is required
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Parameter Data Type Null Required Description and Validations
p_party_site_id NUMBER NOT (see The system-generated identifier
NULL  Description  for the party site location from
and
Validations) HZ_PARTY_SITES

One, and only one, of the two
parameters p_network_loc_id and
p_party_site_id is required

p_work_order_ VARCHAR2 NULL Work order number

number

p_transaction_ DATE NOT YES Date of the transaction

date NULL

E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this APL
2, OUT Parameters :

Parameter Data Type Description

p_return_status VARCHAR2  Returns the status of the transaction:
FND_API.G_RET_STS_SUCCESS - successful
FND_APILG_RET_STS_ERROR - error
FND_APLG_RET_STS_UNEXP_ERROR - unexpected
error

p_error_msg VARCHAR2  The error message

4.2.2 Proj_ltem_Uninstalled

Procedure Proj_Item_Uninstalled

(p_item_id IN NUMBER,
p_revision IN VARCHAR?2,
p_lot_number IN VARCHAR?2,
p_serial_number IN VARCHAR?2,
p_quantity IN NUMBER,
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p_project_id
p_task_id
p_network_loc_id

p_party_site_id

p_work_order_number
p_transaction_date
p_transacted_by
p_return_status

p_error_msg

Parameter Descriptions

IN
IN
IN

IN

NUMBER,
NUMBER,
NUMBER,

NUMBER,

VARCHAR?2

DATE,

NUMBER,
OUT VARCHAR?,
OUT VARCHAR?2)

The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number = VARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
p_project_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the project
p_task_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the task
_network_ NUMBER NOT (see CLLI code from HZ_LOCATIONS
oc_id NULL g)nescrlptlon One, and only one, of the two
Validations) parameters p_network_loc_id and
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Parameter Data Type Null Required Description and Validations
p_party_site_id NUMBER NOT (see The system-generated identifier
NULL  Description for the party site location from
and HZ_PARTY_SITES.
Validations)
One, and only one, of the two
parameters p_network_loc_id and
p_party_site_id is required
p_work_order_ VARCHAR2 NULL Work order number
number
p_transaction_ DATE NOT YES Date of the transaction
date NULL
E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this APL

2. OUT Parameters :

Parameter Data Type Description

p_return_status VARCHAR?2 Returns the status of the transaction:
FND_API.G_RET_STS_SUCCESS - successful
FND_APILG_RET_STS_ERROR - error
FND_APLG_RET_STS_UNEXP_ERROR - unexpected

error

p_error_msg VARCHAR2 The error message

4.2.3 Proj_ltem_In_Service

Procedure Proj_Item_In_Service

(p_item_id IN NUMBER,
p_revision IN VARCHAR?2,
p_lot_number IN VARCHAR?2,
p_serial_number IN VARCHAR?2,
p_quantity IN NUMBER,
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p_effective_date IN DATE,
p_project_id IN NUMBER,
p_task_id IN NUMBER,
p_network_loc_id IN NUMBER,
p_party_site_id IN NUMBER,
p_work_order_number IN VARCHAR2,
p_transaction_date IN DATE,
p_transacted_by IN NUMBER,
p_return_status OUT VARCHAR?2,
p_error_msg OUT VARCHAR?2)

Parameter Descriptions
The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number = VARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
p_effective_ DATE NOT YES Date the asset was placed in
date NULL service
p_project_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the project
p_task_id NUMBER NOT YES The system-generated number
NULL that uniquely identifies the task
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Parameter Data Type Null Required Description and Validations
_network_ NUMBER NOT (see CLLI code from HZ_LOCATIONS
oc_id NULL g)nescrlptlon One, and only one, of the two
Validations) parameters p_network_loc_id and
p_party_site_id is required
p_party_site_id NUMBER NOT (see The system-generated identifier
NULL Description  for the party site location from
and HZ_PARTY_SITES.
Validations)
One, and only one, of the two
parameters p_network_loc_id and
p_party_site_id is required
p_work_order_. VARCHAR2 NULL Work order number
number
p_transaction_ DATE NOT YES Date of the transaction
date NULL
E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this APL

2. OUT Parameters :

Parameter Data Type Description

p_return_status VARCHAR2  Returns the status of the transaction:
FND_APILG_RET_STS_SUCCESS - successful
FND_APLG_RET_STS_ERROR - error
FND_APLG_RET_STS_UNEXP_ERROR - unexpected
error

p_error_msg VARCHAR2  The error message

4.2.4 In_Service

Procedure In_Service
(p_item_id

p_revision

IN NUMBER,
IN VARCHAR?,
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p_lot_number IN VARCHAR?2,
p_serial_number IN VARCHAR?2,
p_quantity IN NUMBER,
p_network_loc_id IN NUMBER,
p_party_site_id IN NUMBER,
p_work_order_number IN VARCHAR2,
p_transaction_date IN DATE,
p_transacted_by IN NUMBER,
p_return_status OUT VARCHAR?2,

p_error_msg

Parameter Descriptions

OUT VARCHAR?)

The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number = VARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
_network_ NUMBER NOT (see CLLI code from HZ_LOCATIONS
oc_id NULL g)nescrlptlon One, and only one, of the two
Validations) parameters p_network_loc_id and
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Parameter Data Type Null Required Description and Validations
p_party_site_id NUMBER NOT (see The system-generated identifier
NULL  Description for the party site location from
and HZ_PARTY_SITES.
Validations)
One, and only one, of the two
parameters p_network_loc_id and
p_party_site_id is required
p_work_order_ VARCHAR2 NULL Work order number
number
p_transaction_ DATE NOT YES Date of the transaction
date NULL
E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this API.

2. OUT Parameters :

Parameter Data Type Description

p_return_status VARCHAR?2 Returns the status of the transaction:
FND_APILG_RET_STS_SUCCESS - successful
FND_APIL.G_RET_STS_ERROR - error
FND_APLG_RET_STS_UNEXP_ERROR - unexpected

error

p_error_msg VARCHAR?2 The error message

4.2.5 Out _Of Service

Procedure Out_Of Service

(p_item_id IN NUMBER,
p_revision IN VARCHAR2,
p_lot_number IN VARCHAR?2,
p_serial_number IN VARCHAR?2,
p_quantity IN NUMBER,
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p_network_loc_id IN NUMBER,
p_party_site_id IN NUMBER,
p_work_order_number IN VARCHAR?,
p_transaction_date IN DATE,
p_transacted_by IN NUMBER,
p_return_status OUT VARCHAR?2,
p_error_msg OUT VARCHAR?2)

Parameter Descriptions

The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number = VARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
_network_ NUMBER NOT (see CLLI code from HZ_LOCATIONS
oc_id NULL g)nescrlptlon One, and only one, of the two
Validations) parameters p_network_loc_id and
p_party_site_id is required
p_party_site_id NUMBER NOT (see The system-generated identifier
NULL Description  for the party site location from
and HZ_PARTY SITES.
Validations)
One, and only one, of the two
parameters p_network_loc_id and
p_party_site_id is required
p_work_order_. VARCHAR2 NULL Work order number
number
p_transaction_ DATE NOT YES Date of the transaction
date NULL
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Parameter Data Type Null Required Description and Validations
E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this APL
2. OUT Parameters :

Parameter Data Type Description

p_return_status VARCHAR2  Returns the status of the transaction:
FND_APLG_RET_STS_SUCCESS - successful
FND_APLG_RET_STS_ERROR - error
FND_APLG_RET_STS_UNEXP_ERROR - unexpected
error

p_error_msg VARCHAR2  The error message

4.2.6 Item_Move
Procedure Item_Move

(p_item_id IN NUMBER,
p_revision IN VARCHAR?2,
p_lot_number IN VARCHAR?,
p_serial_number IN VARCHAR2,
p_quantity IN NUMBER,
p_from_network_loc_id IN NUMBER,
p_to_network_loc_id IN NUMBER,
p_from_party_site_id IN NUMBER,
p_to_party_site_id IN NUMBER,
p_work_order_number IN VARCHAR?2,
p_transaction_date IN DATE,
p_transacted_by IN NUMBER,
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p_return_status

p_error_msg

Parameter Descriptions

OUT VARCHAR?,

OUT VARCHAR?2)

The following table describes the IN parameters associated with this API.

1. IN Parameters :

Parameter Data Type Null  Required Description and Validations
p_item_id NUMBER NOT YES Inventory item identifier
NULL
p_revision VARCHAR2 NULL Item revision code
p_lot_number nVARCHAR2 NULL Lot number
p_serial_ VARCHAR2 NULL Serial number
number
p_quantity NUMBER NOT YES Quantity transacted
NULL
p_from_ ~ NUMBER NOT (see CLLI code from HZ_LOCATIONS
network_loc_id NULL ];;edscrlptlon One, and only one, of the two
Validations) parameters p_from_network_loc_id
and p_from_party_site_id is required
_tq_network_ NUMBER NOT (see o CLLI code from HZ_LOCATIONS
oc_id NULL  Description One, and only one, of the two
and .
Validations) parameters p_to_network_loc_id and
p_to_party_site_id is required
p_from_party_ NUMBER NOT (see The system-generated identifier for
site_id NULL Description  the party site location from HZ_
and PARTY_SITES.
Validations)
One, and only one, of the two
parameters p_from_network_loc_id
and p_from_party_site_id is required
p_to_garty_ NUMBER NOT (see The system-generated identifier for
site_i NULL Description  the party site location from HZ_
and PARTY_SITES.
Validations)
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Parameter Data Type Null  Required Description and Validations
p_work_order_ VARCHAR2 NULL Work order number
number
p_transaction_ DATE NOT YES Date of the transaction
date NULL
E_transacted_ NUMBER NOT YES Employee id of the person
y NULL performing the transaction

The following table describes the OUT parameters associated with this APL
2, OUT Parameters

Parameter Data Type Description

p_return_status VARCHAR?2 Returns the status of the transaction:
FND_API.G_RET_STS_SUCCESS - successful
FND_API.G_RET_STS_ERROR - error
FND_API.G_RET_STS_UNEXP_ERROR - unexpected
error

p_error_msg VARCHAR2 The error message
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